Planning & Development of Smart City: A Case Study on Nashik City

Vipul Bharat Khadke¹, Mansi Santosh More¹, Pramod Prakash Khot¹, Dr. Kalpeshkumar Sharma²

U.G. Student, Department of Civil Engineering, MGM College of Engineering and Technology, Kamothe, Maharashtra, India¹

Associate Professor, Department of Civil Engineering, MGM College of Engineering and Technology, Kamothe, Maharashtra, India²

ABSTRACT: A smart city is an urban development vision to integrate information and communication technology (ICT) and Internet of things (IOT) technology in a secure fashion to manage a city's assets. These assets include local departments information systems, schools, libraries, transportation systems, hospitals, power plants, water supply networks, waste management, law enforcement, and other community services. A smart city is to improve the efficiency of services.

The problem of traffic is increasing in Nashik day by day. About 7,32,008 numbers of vehicles have been registered till the year 2016 in Nashik limits of which two wheelers constitute highest share of 74.6% followed by 4-wheelers with 12.3%. Growth of four wheelers (12.5%) is higher than compared to two wheelers (10.4%). Because of which Total no of accidents in the city in the year 2015 is 1320 of which fatal accidents constitute 213 (i.e. 16%). The total number of accidents are growing at an average annual growth rate of 6.9%. To solve this, we are studying one of the very high traffic density roads of Nashik i.e. from Trimbak Naka to Ashok Stambh under smart road pilot project. The total government cost of project is Rs.16,15,04,998/-, having design life expectancy of 50 years. Based upon our alternate vertical alignment we have, the disposal of 28457Cum material has been reduced to 18566.60 Cum. Also, there is no need to buy the 28923Cum of material for compaction for subgrade.

Also, there is very high-water demand in Nashik due to its population of approximately 19-20 lakh. It has currently total of 415MLD of water supply and NMC will be getting 137MLD up to this year end. Nashik has total of 412.5MLD capacity of water treatment plants. Out of its main 6 regions we will be focusing on the Nashik Road region. We have increased the existing capacity of Water Treatment Plant from 130MLD to 400 MLD. With this, we not only have fulfilled the daily supply requirement of 135LCD but it will also fulfil this demand for next 3 decades.

KEYWORDS: Smart city, Smart pilot road, Water treatment plant, Nashik Smart City.

I. INTRODUCTION

Smart City concept held different meanings from place to place. Smart city meaning for some of the developed countries are entirely different than the developing countries. Also, within the countries also it bears different concept and definition. Hence it is very known what smart city concept is regarding India. For example, United States of America recently released the names of 75 cities that are going to develop as smart cities. From literature Smart city stands for city which utilizes maximum use of Internet and is fully digital. In Malaysia Singapore is the smart city. From Malaysian point of view smart city is all about proper hygienic practices that should be implemented within cities and hence they are concentrating their focus on waste management and hygiene sanitation practices. In Spain Barcelona is the smart city, on published on Barcelona smart city mission Spanish government is more the basis of articles focused on making ease in Transport as well as very clean planning for residential areas in order provides necessary open spaces to city which eases the transportation facilities as well as increase standard of living. Objectives of Smart City

1. Provide Neat Inclusive Healthy and environmental Plan for urban development.
2. Provide adequate water supply.
4. Provide variety of options in Transportation, making it more efficient by reducing traffic congestions.
5. Recycling units to decrease the ill effects on environment and conserving energy
6. Use of renewable sources & natural sources for energy Production.
7. Providing adequate public amenities such as playgrounds, hospitals, Gardens.
8. Reducing pollutions such as air, water etc.

Objectives of Project
1. To study the development of road from Trimbak Naka to Ashok Stambh under smart road pilot project in Nashik (Maharashtra) and suggest an alternate vertical alignment for the same.
2. To study the water supply from the Water Treatment Plant of the Nashik-Mumbai Road, for Nashik road division and increasing the capacity to 400MLD.

II. LITERATURE REVIEW

We need a basic knowledge about the past researches and advancements in this field, before starting the work in it. A Literature Review is a text written on the study of the past work and our understandings from them. In other words, it is a form of work acquired to get the knowledge about the past works and inventions in that field, and to get a clear idea about the methods and ways for going ahead with our work. Literature review isn’t any form of new works, it is only the content taken from secondary sources for reference.

- **Ellie Cosgrave & Theo Tryfonas (2012)**, they have studied Exploring the Relationship between Smart City Policy and Implementation. It states that, the implementations of smart technologies increase the value of the city. The government professionals and the stakeholders are facing various problems in achieving ambitious targets with limited resources. This paper finds the core themes within the field of smart cities & future city policies. The grounded model of smart city is used in this paper. The model has two core influencing features “challenges & opportunities” and “public value”.

- **Anuj Tiwari & Dr. Kamal Jain (2014)**, GIS steering smart future for Smart Cities Projects name LAVASA the three-pillar basic smart city model is used in research paper. The main dimensions of model are Economy, Environment & society. GIS solutions can help the policy makers & planners for decision making purposes. Ultimately this paper helps to understand the use of GIS & its integration with various approaches to formulate, stimulate, interpret and validate the sustainable development of urban areas, steering a smart and sustainable future for smart cities.

- **Taewoo Nam & Thersea A. Pardo (2011)**, Studies about smart city with dimensions of technology, people & institution. “Smart” means innovative & transformative changes driven by new technologies. This concept is an organic connection among technological human & institutional components.

- **Jawad a Shamshi (2015)**, Studies about Architecture: collection, storage & network resource provisioning, step by step implementation toward smart city. Realizing the significance of effective data collection, storage, retrieval and efficient network resource provision the research proposes a high-level architecture for smart city.

- **Preyan Mehta** studies about Democratically smart world. Major force of the world humans, humans' creation and nature. Controlling a force to maintain balance of entire system. Over the period of historical time and throughout our own evolution we have always tried to eat more than we could digest.

- **Jean Jaures** studies about Smart stations issues and limit of hyper connectivity. To achieve full synchronization of physical and digital network, without any disruption, is a work in progress. Smart mobility cannot avoid what we might call of resistance of space a kind of intrinsic heaviness of what is already spatially there which is not always flexible and which will clearly not have same reactivity as the immaterial layer that intend to rele it.

- **Prof. Rahul Wantumur Dr. Murlidhar Dhanawade (2016)**, has provided with the Use of Internet of Things for Building Smart Cities in India in NCRD’s Technical Review. Indian cities and cities around the world are gradually evolving. It is not a sudden decision with planned infrastructure in advance. The concept of Smart City has suggested in a planned city, with such impact that each activity carried out in the city is supervised and controlled by technology. Internet of things is an emerging technology in the IT world that can be explored to its zenith to achieve the goal of building a smart city. Building alone is not enough, but to maintain and sustain their identity. The integrity and authenticity are another task to be processed and implemented. There are several challenges in making a smart city in India, as there are several implicit and explicit obstacles that must be confronted.

- **S. Navitha (2015)** studies about Approaches of Information and Communication Technologies (ICT) for building smart cities. Sensor networks, Internet of things, digital infrastructure, bulky data generated from biological websites, social networking, GPS. Classification of sets of structured and unstructured data and integrate them into the cloud environment with appropriate hardware, software and interfaces.

- **Sabhijit Sing Sandhu et al (2015)** studies about “agent based intelligent traffic management system for smartcities. “A traffic model-intelligent agent that control the amount of time implemented a green light to run based on the number of cars standing in the light.
III. METHODOLOGY

Government of India’s smart city mission

Smart Cities Mission is an urban renewal and retrofitting program by the Government of India with a mission to develop 100 cities (the target has been revised to 109 cities) all over the country making them citizen friendly and sustainable. Union Ministry of Urban Development is responsible for implementing the mission in collaboration with the state governments of the respective cities. The Government of India under the Hon'ble Prime Minister Shri Narendra Modi has a vision of developing 100 smart cities as satellite towns of larger cities by modernizing the existing mid-sized cities.

Fig. 1. Smart Solution

Government methodology

Government of India looks problem solving approach briefly in four ways. That means four various methods can be adopted to tackle the problem. Four methods are listed below

1. Retrofitting:
   Retrofitting approach is the planning in an existing built-up area. In this Approach consisting more than 500 acres will be surveyed first. In this survey area various elements that exist are to be examined first in order to get proper estimation of exact situation. Then necessary provisions are to be made. Looking in the objectives of smart city project things that are necessary, only that things will be provided. This approach is useful for many cities that are already made but, there is a scope to turn them smart to some extent.

2. Redevelopment:
   Redevelopment will affect a replacement to the already existing built up Environment and enable to create new layout of the, selected region. In redevelopment of Particular area, criteria set by authorities is that selected area must be consisting more than 50 acres of land but less than 500 acres.

3. Pan city:
   Pan city approach is application of selected smart solutions to Major cities. As major cities are already reached at their saturation point it is not possible to redevelop or retrofit hence only certain smart solutions like rain water harvesting projects, recycling and reusing, waste water treatment plants etc.

4. Greenfield:
   Greenfield will be developing the smart city on vacant area. This approach is to develop entire smart city from zero. Selected area must be at least 250 acre Using innovative planning one has to plan smart city meeting all the requirements needed. Amravati, New capital of Andhra Pradesh is the first smart city project constructing according to the Greenfield approach Dholera project as well as GIFT city in Gujrat is best example for Greenfield approach.

Nashik a Smart City

National Smart Cities Mission is an urban renewal and retrofitting program by the Government of India with the mission to develop 100 smart cities across the country making them citizen friendly and sustainable. In Maharashtra Nashik is one of the cities nominated by the state for its development as a smart city. Nashik provides a blend of tradition and modernism as it strives to be one of the leading cities in India to live, work and play. It provides city
living at its best, with convenient and affordable public transport, safe and sustainable civic services and a responsive local government. Nashik chooses to preserve its cultural heritage while creating a sustainable future. Nashik prides itself in being a safe city to walk and cycle.

Fig. 2. Strategic Plan

Brief detail of project work on ‘Smart Road Pilot Project’

The given road has been constructed on the existing road which was in a very bad condition. Due to which the road has a fixed horizontal alignment. Also, this road has District collector’s office, 4 Hospitals, SBI Nashik main branch office, and many local food venders’ shops. So, this is a very important road and it has frequent traffic jams. We have suggested the alternate vertical alignment for the road so as to reduce its material disposal charges and to reduce the cost.

Software we used for this project are:

1. InfraWorks 360
2. AutoCAD Civil 3D

Algorithm InfraWorks360

STEP 01: Start the InfraWorks software.
STEP 02: Click the “Model Builder” button on the top menu bar.
STEP 03: Move and zoom in on area of the map in the Model Builder window. Click the “Road” drop-down list to display a list of map viewing options.
STEP 04: Move over the buttons in the “SELECT DATA SETS” area of the Model Builder window to display feature descriptions for each.
STEP 05: Click the second icon in the AREA OF INTEREST area. Select a rectangular area on the map in the Map Builder window.
STEP 06: Enter a name for the new model in the “Name” field. Click the “Create Model” button, a new model is being prepared.
STEP 07: Click the “Cloud” icon in the box for the new model on the home screen to begin downloading the new model.
STEP 08: To create a proposed street style open the InfraWorks model, navigate to the Style Palette in the InfraWorks window.
STEP 09: Click the “Road” tab to view all of the Road Styles included with InfraWorks 360. Reset the original road style in the model. Click and drag the “Local Street” road style in the system.
STEP 10: For sketching of the road navigate to the “Roads Draw Styles” dropdown list, and then select “Proposed Local Street.”
STEP 11: Click the centerline on the road on the left side of the model to select it. Close the “Select Draw Style” dropdown list to view the newly sketched road.
STEP 12: To convert the sketch road into Design road right-click the new sketch road, and then select “Edit” from the pop-up menu. Click “Convert Design Road” on the pop-up menu.
STEP 13: Click and select the “T” intersection on the left side of the new road. Click the “Design Vehicle” button in the Intersection palette on the right side of window.
STEP 14: To create a New Proposal, click “Proposal,” and then select “Add New.” Enter a name for the new proposal and click “OK.”

STEP 15: Select the “Proposed Local Street” style in the Select Draw Style palette. Select points of intersection for the new road in the model window.

STEP 16: Right-click the end point of the new design road, and then select “End Draw” to finish creating the new road and update the model automatically.

STEP 17: Open the Model Properties dialog window in InfraWorks 360. Click the “UCS” drop-down list in the Coordinate Systems area, and then select “IND-IIIB/a” from the list. Click the “OK” button to apply and save the changes. STEP 18: Close the model in InfraWorks 360.

Algorithm of Auto Civil 3D

STEP 01: Open the Civil 3D Edit Drawing Settings. Set up coordinate system. Configure InfraWorks 360 - Civil 3D Exchange Settings and Import data from InfraWorks.

STEP 02: To Edit Surface Properties Hide unwanted contour and Edit Alignment Properties. On Station Control tab set Station field value to “0+100.00” Add Design Speed 50KmH.

STEP 03: To Create line and curve design checks enable the use criteria-based design, give the new line design check a name Enter “Length<= ((Design Speed) *20)” in the field.

STEP 04: Right-click “Curve” in the “Design Checks” list. Click the “New” option Enter “Radius>= (((50) ^2)/ (127*(0.18+(0/100))))” in the field.

STEP 05: Create a new design check set for horizontal alignment and give it a name. Apply new design check set. Check for design violations.

STEP 06: If there is a design violation, right-click the alignment line in the profile view. Select edit profile geometry on popup list. Click the profile grid view button on the profile layout tools toolbar. Edit settings for PVIs in the profile entities window.

STEP 07: If there is no design violation, on the analyses tab click the visibility check button. Select check sight distance. Enable the use alignment and profile option button.

STEP 08: Click the dropdown list and select the alignment. Select the surfaces to check against and then select existing ground surface. Change the data as per the design specifications. Click the finish button.

STEP 09: To Check the Sight analysis report, click the “Assembly” dropdown button. Click the “Create Assembly” button on the list.

STEP 10: Click the “OK” button to close it and insert a new assembly in the drawing To Import custom assemblies, click the “Assembly” dropdown button, and then select “Create Assembly.” Enter a name for the new assembly, and then click “OK.”

STEP 11: Click a point in the drawing to specify the baseline location for the new assembly and insert it.

STEP 12: To create Corridor, Click the “Corridor” button on the Home tab. In the Create Corridor window, enter a name for corridor. Click the “Alignment” selection icon to the right of the Alignment field. Click on alignment to select it.

STEP 13: Click the “Assembly” drop-down list and select “Road Section.” Click the “Target Surface” dropdown list and choose “Existing Ground Surface.”

STEP 14: To create corridor surface for quantities, Right-click the corridor alignment selects “Corridor Surfaces” then click the “Create a corridor surface” button, when the “Pick Corridor Surface Style” window opens, select a style from the list and click the “OK” button.

STEP 15: Click the “Specify Code” dropdown list, and then select “Top.” Click the “+” button to the right of the drop-down list. Click the “Overhang Correction” drop-down list selects “Top Links.” Enable the “Add as Break line” option. Click the “Create a corridor surface” button and then select the new corridor surface row in the table. Rename the field “Rural Road Datum”.

STEP 16: To calculate volume between two surfaces, Click the “Volumes Dashboard” button on the Analyze tab of the ribbon. Click the “Create Surface” button in the Volumes Dashboard window.

STEP 17: Click the “Type” drop-down list and select “TIN Volume Surface.” Select the “Name” field in the Information section. Enter an appropriate name for the new surface. Click the “Comparison Surface” button Select “Rural Road DATUM: in the Select Comparison Surface window, and then click “OK.”

STEP 18: In the Create Surface window, change the “Fill Factor” value to “3” and click “OK.”. Balance Volumes by Performing Profile Edits. To Examine the Difference in Total Volume, when Using TIN Volume Surfaces and Grid Volume Surfaces, Click the “Volumes Dashboard” button on the Analyze tab of the ribbon.

STEP 19: On the Volumes Dashboard, click the “Create Surface” button. Enter a name for the new surface in the Create Surface window change the value to “Grid volume surface.” Change the “Base Surface” value to “Ground” and the “Comparison Surface” value to “Rural Road DATUM.”
Brief detail of project work on Water Treatment

This Water treatment plant is designed for receiving water from Mukane dam from Nashik. Currently, this WTP every day receives 130 MLD water. This quality is calculated with help of latest equipment present at WTP which gives data of flow of water at any given time. 6 pumps are located at base at raw water pump station to provide pressure so that water reaches WTP. These 6 pumps are of 215HP having 90% efficiency. Among these 6 pumps, 3 pumps are running whereas rest 3 pumps are used as stand by. Each pump has a capacity of discharging water of around 1600 cumec/hr. this water then enters intake chamber at WTP. Here, this running water is added with required amount of alum and chlorine for settling of sludge and killing bacteria respectively. From intake chamber water is allowed to run into 2 clarifiocculator. These clarifiocculator having diameter of 52m and depth of 5.2 m (3.5m actual depth and 1.2m depth for sludge digestion) are designed such that it can hold around 68MLD of water each. From clarifiocculator water is allowed to flow filter beds for settling of sludge. These filter beds are placed on two side of walkway, having 7 filter beds on each side. Thus, there are 14 filter beds in total and these beds are designed of depth of 1.2m having capacity of 415 /cumec each. Water from filter bed is carried in 1200mm diameter PSC pipe for chlorination to kill bacteria which is then further passed into the tank at pump house. The tank has capacity of 12ML per hours. Water is discharged with help of pumps. This pump house consists of 4 pumps of 750 Hp each having capacity of discharging water at 3000
cumec per hour. Thus, water from this pump house is then discharged to required area. If in case quantity increases then this exceeded water is supplied to neighboring areas.

**Details on Water Treatment Plant**

Nashik city is fragmented in 6 divisions for over-all operation i.e. Satpur, new Nashik, Panchvati, Nashik east, Nashik west and Nashik road. In our project we are mainly focusing on the Nashik Road Division. With the Nashik Jeevan water supply can pan city project the water treatment plant of Nashik road division i.e. Mukane water supply scheme having current capacity of 130MLD is to be expanded to be the 400MLD.

The work at Mukane dam include construction of water treatment plant with a capacity of 400 million liter per day and an 18 km pipeline. The height of dam about lowest foundation is 26.93 m while the length is 1,530 m. the volume content is 2,271 km and gross capacity is 214,1600.00 km.

**Components of water treatment plant**

1. **Cascade aerator:**
The term aeration in water treatment practices is applied to that process in which water is brought into contact with air. Application to improve the physical and chemical characteristics of water for domestic, commercial and industrial use. Stepped cascades are considered as a very efficient means of aeration because of its strong turbulent mixing characteristic, making the large residence time and the substantial air bubble entrainment.

2. **Clariflocculator**
Clariflocculator is a combination of flocculation and Clarification in it has two concentric tanks where inner tank serves as a flocculation basin tank serves as clarifier. The clarified liquid is discharged over a peripheral weir into the peripheral launder. The deposited sludge is raked to the bottom near the central weir from where it is routed to the sludge chamber and discharged.

**Clarifier system:**
Fluid system offers a wide range of clarifiers to suit various clarification application from pre-treatment to effluent treatment. This also provides maximum setting time causing efficient separation of settled particles from water.

3. **Rapid sand filter:**
The rapid sand filter or rapid gravity filter is a type of filter used in water purification and is commonly used in municipal drinking water facilities as part of multiple stage treatment system.

4. **Post chlorination:**
Final step in the treatment of water. It is a method of adding a minimum level of chlorine into the water mainstream down to distribution. High level of these metal in water can lead to health hazards as well as economic and aesthetic problems.

**IV. RESULT**

**Smart Road Pilot Project**

With our suggested alignment, the disposal of 28457Cum material has been reduced to 18566.60 Cum. Also, there is no need to buy the 28923Cum of material for compaction for subgrade. With this the project cost can be reduced and money could be used for additional features. Also, with the addition of environmental censors we can get real time data of the environmental factors like wind, humidity, CO\(_2\) levels, Temperature, etc. With the WIFI points the local people can get the high-speed internet connectivity for free.

The added advantage is, this road has transferred all the overhead electrical wire connection underground, so the threat for their damage by environmental activities also has been reduced. Also, with the addition of extra lane and cycle lane will reduce the frequent traffic problem on the road.

<table>
<thead>
<tr>
<th>Sr No</th>
<th>Description</th>
<th>Unit</th>
<th>Present Qty.</th>
<th>New Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Disposal of Excavated Material from Road with Lead of 10Km Cum</td>
<td>Cum</td>
<td>28457</td>
<td>18566.60</td>
</tr>
<tr>
<td>2</td>
<td>Compacting the existing Subgrade with power roller including artificial watering etc. complete</td>
<td>Cum</td>
<td>28923</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>Total wastage of material</td>
<td>Cum</td>
<td>57380</td>
<td>18566.6</td>
</tr>
<tr>
<td>4</td>
<td>Material cost for Rs 1250 Per 1 Brass (1 Brass ≈ 2.83 Cum)</td>
<td>Rs.</td>
<td>2,53,44,523</td>
<td>82,00,795</td>
</tr>
</tbody>
</table>
Water Treatment Plant

In the water treatment plant, we have increased the existing capacity of plant from 130 MLD to 400 MLD. With this, we not only have fulfilled the daily supply requirement of 135LCD but it will also fulfil this demand for next 3 decades, to Nashik road Division and New Nashik Division. The excessive water until require in this division, will be transferred to NMC to use as they see fit by Larsen and Toubro (L&T).

Table 2 Present and Future Components Of WTP

<table>
<thead>
<tr>
<th>Sr No</th>
<th>Components</th>
<th>Present</th>
<th>Future Allocated</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Intake</td>
<td>130 MLD</td>
<td>270 MLD</td>
</tr>
<tr>
<td>2</td>
<td>Cascade Aerator</td>
<td>1 (130MLD capacity)</td>
<td>2 (135 MLD capacity each)</td>
</tr>
<tr>
<td>3</td>
<td>Raw water pumps Discharging capacity</td>
<td>6 pumps (3 standby / 3 running)</td>
<td>8 pumps (4 standby/ 4 running)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>215 hp</td>
<td>2000 cumec/hr/pump</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1600 cumec/hr/pump</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Clariflocculator</td>
<td>2 numbers</td>
<td>4 numbers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Capacity-68MLD</td>
<td>Capacity-68MLD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>52 m diameter</td>
<td>52 m diameter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.2 m water depth</td>
<td>5.2 m water depth</td>
</tr>
<tr>
<td>5</td>
<td>Filter bed</td>
<td>14 filter beds</td>
<td>30 filter beds</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Capacity-130MLD</td>
<td>Capacity-270MLD</td>
</tr>
<tr>
<td>6</td>
<td>Pump house</td>
<td>6 pumps</td>
<td>8 pumps</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3000 cumec/ hr</td>
<td>3000 cumec/ hr</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Capacity-6ML/hr</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 pumps</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3000 cumec/ hr</td>
<td></td>
</tr>
</tbody>
</table>

V. CONCLUSION

With our suggested alignment, the disposal of 28457Cum material has been reduced to 18566.60 Cum. Also, there is no need to buy the 28923Cum of material for compaction for subgrade. With the provided alternate alignment of the Ashok Stambh to Trimbak naka road we can reduce the cost of the project for the added material for compaction from Rs. 2,53,44,523 to Rs. 82,00,795 which saves the Rs. 1,71,43,728. With the addition of extra lane and cycle lane will reduce the frequent traffic problem on the road.

In water treatment plant, Mukane water supply scheme provides 130MLD water to Nashik Road Division and the New Nashik Division. The have the combined population of approximately 11,45,000. So, there is the shortage of 24.575MLD. With our extended capacity of 400 MLD, the water demand will not only be satisfied but will be sufficient for the next 3 decades. The excessive water until require in this division, will be transferred to NMC to use as they see fit by Larsen and Toubro (L&T). This project will solve the current water related problems in these 2 regions.

REFERENCES

[7] http://www.smartnashik.in